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This manual is intended to provide HRSD commissioned Engineers and Contractors guidance on using
the Unifier Enterprise Project Management System
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Oracle’s Primavera Unifier provides the means to optimize HRSD business processes and allows
transparency to enable customers better management of all the information required to successfully
manage a project.
Managing projects from design through completion of construction as well as regular maintenance
requires extensive collaboration between numerous, often a variety of diverse, disciplines and
jurisdictions. Ensuring accurate and current information for a project is essential for the successful
completion of any project.

PRIMAVERA UNIFIER™
Unifier is a system for managing the flow of information in projects, providing a seamlessly automated
and integrated environment across the lifecycle of your company’s facilities, from planning, design,
procurement, construction, and into operations and maintenance. It provides real-time visibility across
multiple projects to help your company make fast, accurate decisions. Unifier lets you track and manage
information such as budgets, project members, specifications, requests for information, and shared
documents. You decide who has access to the information, which team members are allowed to
approve changes to the information, and how information flows between people.
Oracle’s solutions automate manual processes and pull together information from various point systems
typically used on a portfolio of projects. Through Unifier, executives and project team members can
better manage all data and business processes in one centralized system, while reducing the reliance on
older technologies such as email, fax, and desktop applications.
Unifier was designed from the ground up specifically for the facility owner, based upon our industry
domain expertise and knowledge of best practices combined with direct customer input gathered over
decades of client interaction. The result is a robust set of capabilities with an intuitive, easy-to-use
interface. Unifier enables leading owners and operators to increase enterprise efficiencies reduce
project and operating costs, enhance visibility, and improve time-to-market.
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Access to Unifier is located at https://uhrsd-unifier.oracleindustry.com
User names and temporary password will be provided by the Unifier Administrator. Contact
your project manager or the Unifier Administrator (unifieradmin@hrsd.com) to schedule a
training session.
Initial Log In
It is highly recommended that, prior to logging into Unifier for the first time, each user reviews
the table below regarding compatibility between internet browsers and Java. As of April 15,
2016, the recommended Java version is Java 8.73 32-bit.
Please note that, as of September 1, 2015, Google Chrome no longer supports the Java plug-in
(click here for additional information).

Once users log in with their temporary password, they will be required to change their
password and set security questions.

HRSD |

4

NAVIGATION

UNIFIER USER MANUAL

Unifier employs a tab based navigation system. The initial log in will bring the user to the Home
tab. Individual user permissions and user preferences will alter the amount of information that
each user can view.

USER SETTINGS
There are a limited amount of user preferences that can be used to configure Unifier for the
individual user.
Bookmarks
Each location throughout Unifier can be recorded as an individual page by clicking on Bookmark
(the star in the upper-left corner).

•
•
•

Type in a name for the bookmark then click Add to create a bookmark
Bookmarks can be organized by renaming them or moving them up or down
Bookmarks can be used to direct which page is the default log in view
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Preferences
The preferences menu has several tabs for individual user settings and can be accessed by
clicking on the user’s name in the upper-right corner

General
-This tab contains all the contact information for the
specific user logged into Unifier.
-Submit any updates to contact information to the
Unifier Administrator
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User passwords can be changed by logging into

https://uhrsd-unifier-idm.oracleindustry.com/oim or
contacting the Unifier Administrator.

Security questions to recover user passwords can
be edited in this tab.

Options

Default Viewer
Default viewer can be Native or Unifier
Viewer
-Native viewer uses programs installed on
user’s
computer to view files.
-Unifier viewer allows user to view files of
any file type even if that program is not
installed (functionality is limited)
File Transfer Option
Basic – allows for attachment of one
document at a time
Intermediate – allows for selection of
multiple documents to attach*
Advanced – allows for drag and drop of
documents into Unifier*
*An additional Java plug in must be
downloaded for this option to function (See
Help/Download Plugins)
Notifications
Users can use checkboxes to decide which
tasks send a notification to user’s email
account.
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Setting proxies allow other Unifier users to take
action on tasks assigned to another Unifier user.
Add: Select other Unifier licensed user
Set Start and End Date/Time
Proxy Login: Select user name and click Proxy
Login. The window will refresh and will read “Your
name on behalf of other user.”

Help

Select the dropdown menu next to Help to access support options.

Contact Support – Contact information for Unifier
Administrator

Download Plugins – Link to download Java plug in
need for Advance File Transfer Option. To install,
click on the link and follow the instructions to
Run the Install setup. See Appendix B for
detailed instructions.
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There are multiple ways to navigate through projects in Unifier.
Home Overall summary of all:
• Oracle issued announcements
• Tasks requiring attention
Company Workspace HRSD specific activities
• Company Business processes
• Unifier Administration
Capital Projects/Archived Capital
Projects/Completed Capital Projects* Project Level
• BPs and Document manager
• Cost and Schedule sheet
Selecting the plus (+) sign will allow users to open additional tabs and select between Recent
Locations and Key Locations. Users can add as many tabs as needed (i.e. one for each project
assigned).
Tabs will remain active after logging out and will continue to stay active until closed (X) out.
When navigating between tabs, the last location visited will still be available.
*Please note that the Archived Capital Projects and Completed Capital Projects tabs were
created April 22, 2015. Users that were granted permissions prior to this date are able to access
the projects in these tabs.
“Navigate to” Search for projects in the
“Navigate to” field located on the upper left.
Previous locations will be shown in a
dropdown menu when you click in the field.
“Breadcrumbs” Users can click on the arrow
next to a listed page and view options
available.
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User can access all assigned tasks throughout Unifier in this single summarized tab.
Tasks

This shows all the work the logged in user must take action on. It includes all the tasks assigned
and/or accepted by the user across all projects the user is a member of.
Company Workspace Tab
The Company Workspace Tab is primarily used for HRSD administration of the Unifier program.
Only two company-level business processes are initiated from the company workspace tab:
Project Requests and Vendors.

Immediate access to Unifier Administrator email, the HRSD webpage, and the user Reference
Manual is provided.
Reports
Company level reports can be accessed from the Company Workspace tab. Specific permissions
will need to be granted for access to each report.
Capital Projects (including Archived and Completed) Tab
Each individual project can be accessed separately and more thoroughly via the Capital Projects
tabs.
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Capital Projects – Contains current, proposed, and warranty projects prior to completion.
Archived Projects – As of May 4, 2015, any projects that were available in the Capital Projects
tab were copied over to the Archived Projects tab. The archived versions of the projects were made

in order to be compatible with the E-Business Suite (EBS) due to our new accounting structure. The
archived version of these projects will only be used to reference records that were entered prior to the
switchover (historical).
Completed Project – Contains projects that have closed out and are complete per Accounting.

To search for a specific project, click on Find to run a search for CIP Number, Project Name
and/or System.

Project Specific Details
Double clicking on one individual project will provide user with detailed information on the
project, summary of actions, and project specific functions.
Details
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Top right corner of the project page provides you with summary project details:
• Project name and CIP number
• Detail information on the project (system, type, status, priority score)
• Project Description and Justification
Detailed project specific actions

Project Specific Email Address
Each project is assigned its own unique email address. Correspondence about each project
should use this address so that all documentation is stored for future reference.

Alerts
An alert will notify the user of an overdue task or custom alerts can be created for notification
of project milestones.
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Mailbox
The mailbox is the repository for all emails sent to the project specific email address.
Collaboration
Tasks – User can create new or take action on business
processes from this option.
Messages – User can view messages regarding business
processes that they were cc’d on.

Drafts – New business processes can be created from this
option and will be saved as a draft until sent to another user to
take action.

Cost Manager
Cost Manager provides summary cost information on project budget, encumbrances, and
expenditures.
Cost Sheet - Information in the cost sheet is supplied
through the E-Business Suite (EBS)-Unifier interface. Access
to the cost sheet is permission controlled.
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Schedule of Values - Information in the Schedule of Values
is supplied through the E-Business Suite (EBS)-Unifier
interface. Access to the cost sheet is permission controlled.

Budget BP
Appropriated Budget – Appropriated Budgets
are entered after approval from the
Commission

CIP Budget BP – The CIP Budget BP is
completed at the time new CIP projects are
added.

Document Manager
The Document Manager (DM) is a repository for all documents that need to be stored with the
project but do not come in through a business process record. The upper level folder structure
of the DM is fixed but folders can be added below the upper level.
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Creating a folder:
First highlight the section of the DM that you want to add a new folder to. Click on the New
button, or the arrow next to the New button and select folder. A window will open asking you
to name the folder and add any other metadata you wish. Once the folder is created you can
add specific permissions, via the permissions button, or assign properties to the folder via the
properties button.

Adding a document:
To add a document to a DM folder first highlight the folder and then click on the Upload button.
A window will then open allowing the user to browse their computer for the file to be
uploaded.* This process is the same as adding an attachment to a business process.
*The upload window may look different depending on the File Transfer Option selected in
Preferences (see Frequently Asked Questions, 2. b). To upload folders and files, expand the
Advanced Options and select from the Folder Upload Options as shown below.
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Modifying a document:
The Unifier DM is a shared environment which means more than one user can view the same
document at the same time. In order to modify a document in the DM it must first be checked
out. Once the document is checked out it can be modified and then checked back in. The
original version of the document will be saved and the latest version will be displayed when a
user clicks on the file.
To check out a document, click on the Check Out button in the DM menu bar. The first time you
do this, Unifier will direct you to create a folder on your computer to store checked out files.
After you check out the document you can then make edits. Once edits are finalized go back to
the DM, highlight the checked out file and the click on check in document. To view the previous
versions of a file, highlight the file name and then go to the View menu and select Revisions.
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The HRSD Project Manager is the owner of the DM for their projects. If there are any questions
with the folder structure of a project’s DM, or where to store certain files, please contact the
PM.
Schedule Manager
The Schedule Manager is used for internal project metric tracking. Additional schedule sheets
can be added for project management. Schedules can be imported from MS Project and
Primavera. See Appendix for detailed instructions.
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Logs
The Logs module serves as a repository for all in progress and
completed workflow records. User can initiate a business process
record from its specific log.

To audit a log, double click to open the record and select View from the menu. Click Audit Log
to view the user and the action taken for the workflow.
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To print an open record, select File from the menu then Print Preview and select one of the
options available (PDF is recommended).

To view the workflow chart, select the name of the BP to open the log. Select Help from the
menu, then the BPs name Help option. Select Open to view a PDF of the workflow.
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Information is entered and stored in Unifier using electronic business process forms, and routed to
project team members or other Unifier users via fully configurable workflows. Each time you fill out a
business process form, you are creating a new record in Unifier. Within a project, the majority of
business processes are located under the Project Logs node.

Upper Form

Workflow or
Action

Lower Form

Upper Form
The upper portion of the business process contains the basic (General) information that the
form is managing, such as the name of the record and its description, who created the record
and when, and other general information. It may also contain fields for referencing other forms,
and it may contain fields that are required for specific functionality.
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Information in Asterisks (*) is required for work to be reviewed and passed onto the next stage.

Workflow or Action
This section appears in the middle part of workflow business processes. It is for viewing or
assigning the next assignee in the workflow or shows the last person who took action on it.
Depending on how the workflow has been set up for the BP, the next assignees may be
predetermined, or you may be able to choose the next assignee or send a copy of the BP to
another user.
After all the information is entered into the upper form, click on
Workflow Actions then make a selection for the next step of the
workflow. There may be one or multiple options based on
workflow complexity.

When a workflow action has been selected the To and Cc can be filled in. Available selection is
controlled by the business process workflow. The user will only be able to select from an
approved list of users based on the next step of the workflow. This allows for the Business
Process to be passed onto the next stage.
Lower Form
The lower portion of the form contains the details and main content of the record, such as line
items, file attachments for document-type business processes such as transmittals or
submittals, or comments or instructions.
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Attachments
Files can be attached to any BP by clicking on Add Attachment and selecting either Computer or
Unifier Folder.

Linked Records
Another means to attaching additional information to a Business Process is clicking on Linked
Records. Linked records allows for attachments of other related business process records that
reside in a different log.

General Comments
Users can add comments by clicking on general Comments  Add…
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Each comment can be made public or hidden and later Modified and/or Removed
Check Hidden Comment
to make comment hidden.

Submitting a Business Process Record
1. Select the appropriate business process record from either Collaboration/Task or from
the individual business process log.

2. Fill out all required fields in the upper form
HRSD |
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3. Select workflow action. This is necessary to route the record to the appropriate approval
group.

4. Once
workflow
action is selected, select who you want to send the record to for approval. Depending
on the workflow construction, you will be limited to send the record to specific user
groups. You can send the record to any person listed when you click the To button.
Certain workflow steps also allow for a CC of project members. CC will only send a
notification, it
will not
assign a task to
the
selected user.

5. Click SEND. This will send the BP record to the selected user and that user will receive a
notification via email. If there are any required fields that have not been entered, or any
other errors, the BP record will not be sent and an error notification will appear.
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HRSD SPECIFIC BUSINESS PROCESSES
The following Business Processes (BPs) are specific to HRSD project management. Each BP
contains a description, a form preview and workflow (if applicable). The workflows attached to
the listed BPs show which groups can create specific BP records, and which groups are in the
approval path of specific BP records.
Within Unifier, these BP Logs are grouped in the following categories: Payment, Contractual,
Reports-Documentation, Transmittal-Deliverable-Turnover, Project Management, Contract
Admin and Archived.

*The Archived BP Logs are for record purposes only. New logs
cannot be created for these BP’s.
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DESCRIPTION
The Action Items business process is used to request an action to be taken by a team member. Action Items is a
4-step workflow that allows the originator to assign an action item to a team member. Once completed, the
assignee replies back to the originator for Review. Upon review completion, the action item is closed.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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DESCRIPTION
The Asset Activation business process is used to document when a pipeline, section of pipe, or mechanical,
electrical, and/or treatment process system is officially placed into HRSD service. The business process is also used
to document when an asset is deactivated and officially retired from HRSD service. The business process facilitates
HRSD reflecting real time information in the GIS.
FORMS

• Form Preview

WORKFLOW
• Basic Schema
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The Citizen Inquiry business process is a means of creating and then tracking an inquiry or claim through its process
to ensure each item is addressed promptly, by the correct member of the project team, and follow-up is made with
the requestor/claimant. The tracking of pertinent project specific information will help HRSD with preemptive
measures in the future in regards to the public and property.
Note: A claim will originally be logged here as a means of capturing the initial outreach but will follow and finalize
through a separate method (please contact the Community Relations Liaison).

FORMS
• Form Preview

WORKFLOW
•Citizen Inquiry WF (Coordination Required)

•Send directly to log
(No Coordination Required)
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COMPLETION CERTIFICATES
DESCRIPTION

The Completion Certificates business process allows the contractor to submit a request for a substantial completion
certificate or a final completion certificate. Issuance of a Substantial Completion certificate requires the work to be
inspected and a punch list prepared. Issuance of a Final completion certificate requires the work to be inspected to
ensure all punch list items have been completed.

FORMS
• Form Preview

WORKFLOW

• Basic Schema
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CONSTRUCTION SUBMITTALS
DESCRIPTION

The Construction Submittals business process is used to transmit As-Builts, Operation and Maintenance Manuals,
Photos and Videos, and Shop Drawings to a team member to process, send out for collaboration, and review. Each
type of Construction Submittal has its own form and fields. Select the appropriate type of submittal from the
dropdown menu.

FORMS
• Form Preview

WORKFLOW

• Basic Schema
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DAILY/WEEKLY REPORTS
DESCRIPTION

Daily Report business process provides a report of any activity, progress, site visit, issues, resolutions and other
pertinent information on the project. The workflow supports review of the daily report prior to becoming final.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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DESCRIPTION
Design Reviews business process supports electronic review and approval of design documents by the owner.
The form supports large numbers of attachments with support for an entire folder structure, and includes
features for electronic collaboration, commenting, redlines/markups.

FORMS
• Form Preview

WORKFLOW
• Basic
Schema
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DESCRIPTION
The Field Order business process is used by a team member to issue a written order to the Contractor which requires
a minor change to the construction contract that doesn’t impact the contract price or the contract times.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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MATERIAL/EQUIPMENT/SPARE PARTS
DESCRIPTION

The Materials/Equipment/Spare Parts business process is used to document the turnover of material,
equipment, or spare parts from the general contractor to HRSD. The business process identifies the who,
what, when, and where of material, equipment, or spare parts being turned over. The business process logs
facilitate HRSD locating the items in the future.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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DESCRIPTION
The HRSD Contracts business process is automatically generated from contracts processed in E-Business Suite
(EBS).

HRSD |

35

UNIFIER USER MANUAL

HRSD CONTRACT CHANGE
DESCRIPTION

The HRSD Contract Change business process is automatically generated from contracts processed in E-Business
Suite (EBS).
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HRSD PAYMENT APPLICATION
DESCRIPTION

The HRSD Payment Application business process is automatically generated from contracts processed in EBusiness Suite (EBS).
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DESCRIPTION
Meeting Summary allows a team member to create and track pertinent meeting minutes for projects, which can
be sent out for review using the configured workflow. Each line item auto creates a Meeting Minutes-Follow
Up record once the meeting minutes have been approved by all recipients.

FORMS
• Form Preview

WORKFLOW
• Meeting Minutes Flow
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MEETING MINUTES–FOLLOW UP
DESCRIPTION

Meeting Minutes-Follow Up is auto created from the line items of the Meeting Minutes business process once the
minutes have been approved by all recipients. This allows a team member to assign an action item and track
pertinent information for projects, which can be sent out for review and follow up using the configured workflow.
Each line item auto creates a Meeting Minutes-Follow Up record.

FORMS
• Form Preview

WORKFLOW
• Meeting Minutes-Follow Up Flow
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PROFESSIONAL SERVICES DELIVERABLES
DESCRIPTION

The Professional Services Deliverables business process is used to transmit Technical Memorandums, PER’s, Plans
and Specifications during the intermediate design, bid and conformed stages, Record Drawings, and Valve
Guides. Each type of deliverable generates its own form and fields for submission. Select the appropriate type of
submittal from the dropdown menu.

FORMS
• Form Preview

WORKFLOW
• Acknowledgement
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PROJECT MANAGER UPDATE
DESCRIPTION

The Project Manager Update business process allows the Project Manager to provide continual status updates on a
project’s progress. The information provided in the Project Manager Update BP record will be used to create the
Design and Construction monthly report, as well as, other internal project metrics. Only one record is active per
project and will be overwritten each month.

FORMS
• Form Preview
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REQUEST FOR INFORMATION (RFI)
DESCRIPTION

Request for Information (RFIs) business process is to request information or clarification from vendors, contractors,
the owner or other team members. This workflow also allows for submission of a request for proposal (RFP).

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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REQUEST FOR PROPOSAL (RFP)
DESCRIPTION

Request for Information (RFIs) business process is to request information or clarification from vendors, contractors,
the owner or other team members.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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DESCRIPTION
The Risk Items business process provides a log to allow a project manager to identify potential financial impact
on a project and define mitigation plans. Risk Items impact the project forecast.

FORMS
• Form Preview
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DESCRIPTION
The Warranty business process allows the HRSD customer to report items (defects, deficiencies, and issues) that
should be resolved by the contractor during the warranty period. The process documents the reporting and
resolution of the warranty claims.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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DESCRIPTION
The Website Update business process allows the Project Manager or Engineer to provide status updates on a
project’s progress. The information provided in the BP record will be used to update HRSD’s website. Only one
record is active per project and will be overwritten with each revision.

FORMS
• Form Preview
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WORK CHANGE DIRECTIVE
DESCRIPTION

The Work Change Directive (WCD) business process is used by Engineering Consultants or HRSD Project
Managers in order to authorize and/or direct contractors to perform additional work in a timely fashion when scope
of work, cost or time are difficult to determine beforehand or when scope of work, cost, time, responsibility or need
are in dispute. WCD’s are also occasionally used to identify relatively small changes and/or additional work so that
several such items can be combined into a single Change Order.

FORMS
• Form Preview

WORKFLOW
• Basic Schema
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FREQUENTLY ASKED QUESTIONS (FAQ)

1. Why am I unable to view my project in the Capital Projects tab?
This is usually a permission issue. Each user has specific permissions applied to their account. If
you are a Consultant or Contractor for a specific project, you must be granted permissions to be
able to select the project from the list of projects located on the Capital Projects/Archived
Capital Projects tab. Contact the Unifier Administrator or the Project Manager to request access.
2. Why can’t I upload/download documents?
There are multiple causes why users may not be able to upload/download documents.
a. The wrong browser version and/or Java version are the most likely cause for this issue.
Please refer to the compatibility table on Page 4 of the manual to confirm the correct
versions are set.
b. If the correct browser and Java versions are set, another cause may the File Transfer
Option. To check this setting, click on the user name on the top right of the window,
select Preferences, then the Options tab.
There are three choices for the File Transfer Option:
I.
Basic: HTML-based, does not require the installation of special software
II.
Intermediate: requires installation of Java
III.
Advanced: requires installation of Java and the Primavera Unifier File Transfer
Utility (refer to Appendix A for installation instructions)
With the Advanced option, the Unifier File Transfer Utility works in conjunction with
Java to provide the greatest flexibility for uploading and downloading documents and
folders. It supports drag-and-drop uploading/downloading of multiple files and folders.
Its advanced functionality for managing reference file relationships in DWG and DGN
drawing files makes it easier for users to locate, upload, revise and download reference
files. If you are using the Space Manager, the Advanced option must be used for
uploading drawing files into the Space Manager.
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The Advanced File Transfer Option (located under Help>Download Plugins) allows for drag and
drop of documents into Unifier. An additional Java plug in must be downloaded for this option
to function, which is located in Support under the Download tab.
To install, click the link to download the
application required for Advance File
Transfer Option. Follow the instructions
to Run the Install setup.

Double click the application .zip file, then
click Run.

Follow the directions on the
screen, until the final window
confirms the installation.
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The “Initial Schedule” serves multiple purposes. It documents the chronological evolution of the
project and reflects the current project schedule. The “Initial Schedule” sheet is used for the Chief’s
monthly report, metric based reporting, and pushed to GIS for “construction project status.”
The “Initial Schedule” sheet is created, within the Schedule Manager, when a project is entered into
Unifier for the first time.
Columns 1 and 2 are always “ID” and “Activity Name” and do not change.
Columns 3 through 5 (Start date, Finish date, & Duration) are the current status of the project.
These are the columns to be reviewed and updated (if necessary) on a monthly basis by the project
manager.
“Baseline Schedules” are intended to chronicle the project schedule at a certain period in time.
Baseline Schedule
Columns 6 through 8 (Baseline Start, Baseline Finish, & Baseline Duration) are established when
the project is initially entered into Unifier. The purpose of these columns is to chronicle the
schedule at the inception of the project. These dates never change.
Baseline 1 Schedule
Columns 9 through 11 (Baseline 1 Start, Baseline 1 Finish, & Baseline 1 Duration) are established at
the first milestone of the project, likely at the completion of the PER. As the project is further
developed through preliminary engineering, design, and award, the project schedule may change.
The “Baseline 1” schedule chronicles the change in project schedule at the first project milestone.
Baseline 2 Schedule
Columns 12 through 14 (Baseline 2 Start, Baseline 2 Finish, & Baseline 2 Duration) are established
at the second milestone of the project, likely at the completion of the Design. As the project is
further developed through design and award the project schedule may change. The “Baseline 2”
schedule chronicles the change in project schedule at the second project milestone.
Baseline 3 Schedule
Columns 15 through 17 (Baseline 3 Start, Baseline 3 Finish, & Baseline 3 Duration) are established
at the third milestone of the project, likely at the Notice To Proceed. As the project progresses, the
project schedule may change due to a bid delay, a change in CIP priorities, or a construction delay.
Subsequent “Baseline #” schedules chronicle changes in the project schedule.
To ensure uniformity in populating the schedule the following term’s durations are generally
defined as follows:
Pre-Planning = CIP inception until Engineering Services contract award
PER = Engineering Services Award until Design Amendment is approved
Design Delay =optional
Design = Design Amendment approval until Bid Ready documents are received
HRSD |
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Bid Delay = optional
Pre-Construction = receipt of Bid Ready documents until NTP
Construction = NTP until Substantial Completion
Close Out = Substantial Completion until Final Completion (final payment)
Completion = Final Completion
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An attempt to login to Unifier with the wrong password 5 times will lock the user's account and will
display a message stating the "account is locked". To unlock the account, follow the instructions
below:
1. Choose the Forgot Password workflow and follow the steps to set a new password.
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2. Click on Back to Login. Users may be directed to the Oracle Identity Self Service site instead.
In this event, reopen the Unifier login page.

3. Users must wait FIVE minutes before trying to login with new password.
4. If the account is still locked, please contact the Unifier Administrator
(UnifierAdmin@hrsd.com).
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APPENDIX D
Project Audit Documents BP and Gates Module

Project Managers will be able to update project phase (formerly project status) by completing the
Project Audit Documents BP, which will filter into the Chiefs’ monthly reports. The Gates will run daily
but can also be manually refreshed within the Gates menu.

Project Audit Documents
1. The Project Audit Documents BP is located under the Reports-Documentation BP Logs. Click
New to create a log.

Please note: The log will only need to be created once. To open once created, double-click on
the “Approved” status log and click Edit to update the log.
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2. For each document listed within each phase, select Yes, No or N/A (if applicable) from the
dropdown options. If No is selected for any of the documents, the Status will not change to the
next appropriate phase. Select the correct document Location from the dropdown list. The
Comment field is available and will be useful for auditors and other users.

3. Once, editing is complete, click on Finish Editing to save the changes.
4. The Gates will run daily and the project phase will be updated at that time. To manually refresh
the Gates, please see below.
Gates Refresh
1. To manually refresh the Gates to move to the next phase, select Gates from the left menu, and
then click on Refresh. Do not click on Advance to Next Phase.
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2. Each phase will have a check mark when the phase is Complete.

3. To check the current Phase, open the Details form and select Options.
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